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TOPIC -----------------------------------------------------------

This article contains the read me file for the StyleWriter 1200 printer.

DISCUSSION ------------------------------------------------------

Information About Your StyleWriter 1200 Printer

This document contains important reminders and some information that's not in
the user manual.

Installation and Setup Tips

Follow the instructions in the user manual to install the StyleWriter 1200
software. Keep the following tips in mind when setting up and working with your
new software:

•  After installing the printing software, you must create a desktop printer. To
do so, select the StyleWriter 1200 in the Chooser, then close the Chooser.

• If you have a PowerBook computer, see "Special Information for PowerBook
Users" in the section "Telling Your Computer to Use the StyleWriter 1200" in
Chapter 1 of the user manual.

• If you get the message, "Serial port in use by another application, please
quit the application and try again," restart your Macintosh before trying to
print again.

• If you upgrade your system software, you must reinstall the StyleWriter 1200
software.

• Close the Chooser after making any changes to it.
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• See the Troubleshooting chapter in the StyleWriter 1200 user manual for more
information.

• If you have version 7.1 or 7.1.1 of the Macintosh Operating System (Mac OS) in
any language besides English, the Installer program's Easy Install procedure
will replace your version of the Finder with an English-language version. You
can avoid this by using the Installer's Custom Install feature (instead of the
Easy Install feature) to install PrintMonitor 7.1  and QuickDraw Printer
Software. In that case, however, the desktop printer features will be
unavailable to you.

About Desktop Printing

Your new printing software comes with Desktop PrintMonitor version 1.0.3. You
use Desktop PrintMonitor to create printer icons (or "desktop printers") on your
Mac OS desktop. You can print a document by simply dragging it to a desktop
printer icon. Desktop printers also give you more control over printing,
including setting printing priorities and choosing specific times for printing.

Installed Desktop Printing Files

The following files are installed for desktop printing on computers that use
version 7.1 or later of the Mac OS:

•  Desktop PrintMonitor, Desktop Printer Spooler, and Desktop Printer Extension
are placed in the Extensions folder.
•  If your computer has version 7.1.1 or 7.1.2  of the Mac OS, Finder 7.1.3 is
placed in your System Folder and Finder Help 7.1.3 is placed in the Extensions
folder.
•   If your system has version 7.1.1 or 7.1.2 of the Mac OS,  these files are
placed in the Extensions folder: Thread Manager 2.1, Network Extension 7.1.3,
Macintosh Drag and Drop, and Dragging Enabler.

Creating Desktop Printers

You create desktop printers by selecting a printer in the Chooser. A desktop
printer icon appears on your desktop when you close the Chooser.

You can drag this icon to any position you want on your desktop. You cannot move
it off the desktop.
If you want, you can select other printers in the Chooser and create other
desktop printers for easy access. You must close the Chooser each time to create
a desktop printer.

The last desktop printer created becomes the default printer. Your documents
will automatically be printed on the default printer.

Printing With Desktop Printers

You can print documents within your applications as you normally do. You can
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also print documents without leaving the Finder, using one of the two methods
described here. These methods are particularly efficient when you have a number
of documents created by the same application that you want to print at once.

• Drag the icons of the documents (all created by the same application) to the
desktop icon of the printer you want to use.
• Select the icons of the documents you want to print and choose the Print
command from the File menu.

The computer will show you the Print dialog box so you can choose printing
options. Make your choices, then click the Print button.

After a few moments, the document starts to print. If background printing is
turned on, you can continue working while the document is printing.

Selecting a Default Printer

If you have more than one printer available, you can select which you want to
use. The printer you select is called the "default printer." All your documents
will be printed on the default printer until you select a new one.

To change the default printer, use one of these three methods:

• Drag the document you want to print to a desktop printer icon, and it will
automatically become the default printer.
• Select the desktop printer icon and use the Printing menu to set the printer
as the default.
• Select a new printer using the Chooser.

Note:  Switching between printers may change how much information you can fit on
a page. It's best to choose a printer before you spend much time formatting the
document.

Working With Desktop Printer Icons

Desktop printer icons change to indicate printing status:

You can do the following with desktop printer icons:

• Throw away the icon. Drag the icon to the Trash. You can't throw away a
desktop printer icon while the printer is printing a document. (You can create
another desktop printer icon for that printer whenever you like.)

Note:
You must always have at least one printer icon on your desktop. If  you throw
away the last icon, it will immediately be created again.

• Rename the icon.  Rename the icon as you would any other Finder icon. Click
the name to highlight it, then type the new name. This changes the name of the
icon, not the name of the printer.
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• Move the icon.  You may drag the icon anywhere you like on the desktop.
However, you may not move it off the desktop.

• Create an alias for the icon.  You may create an alias for the icon as you
would any Finder icon, by selecting the icon and choosing the Make Alias command
from the File menu. The alias may be moved anywhere on or off the desktop.

Monitoring Printing

If you are using background printing, you can use the desktop printer features
to monitor and control the documents that are waiting to print. To learn how to
turn background printing on and off, see your printer manual.

To monitor the printing of documents:

1  Double-click the desktop printer icon you're interested in.

A window opens listing the documents that are printing or waiting to print.

Watching the status messages can be helpful when troubleshooting printing
problems. When more than one job is waiting to be printed, a list of print jobs
appears in the waiting list, showing the order in which they will be printed
(when sorted by print time.)

2 Choose what you'd like to do.

• To cancel a print request, select it by clicking its icon and click the Remove
button.

You can select only the currently printing document by clicking its icon. (You
can select more than one item at a time by holding down the Shift key while
clicking.) You can also drag the icon for the print request to the Trash. Note
that these methods delete only the print request (also referred to as a spool
file), not the document itself.

• To put a print request on hold, select it and click the Hold button.

The print request will stay on hold until you select it again and click the
Resume button. You can also put the document that's currently printing on hold
by dragging it to the list of documents waiting to print (lower part of the
window).

• To indicate that a print request is urgent, select it and choose Set Print
Time from the Printing menu. In the dialog box that opens, click Urgent.

• To indicate that a print request should not print until a future time, select
it and choose Set Print Time from the Printing menu. In the dialog box that
opens, click At Time, then set the time you want.

• To change the order of the items waiting to print, move their place in the
list by dragging their titles up or down in the list.
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• To sort the list of documents waiting to print, click the title of the column
you want to sort by.

For example, to sort by the name of the document, click "Document Name." (You
can also sort by choosing the commands in the View menu.) The column title you
sorted by is underlined. Sorting the items does not change the order in which
they will print. To see that order, sort by Print Time.

• To temporarily stop all documents from printing on this printer, choose Stop
Print Queue from the Printing menu.

To resume using the printer, choose Start Print Queue from the Printing menu. If
the Desktop PrintMonitor window is open, you can  begin printing the document
from the first page by Option-clicking the Resume button (holding down the
Option key while clicking the Resume button).

 Shortcut: The Printing menu for starting and stopping the print queue is
available without opening the window for the printer, as long as the printer's
icon is selected on the desktop.

• To move a print request from one printer to another printer of the same type
(for example, from a StyleWriter 1200 to a StyleWriter 2400), drag the icon for
the print request to the icon of the printer where you want to move it.

The printing software won't let you move a print request to an incompatible
printer. For example, you can't move a request from a LaserWriter printer to a
StyleWriter printer.

Turning the Manual Feed Notification On or Off

When you install the printer software, the Desktop PrintMonitor is set up to
notify you about manually feeding paper the same way your PrintMonitor was set.
For example, if you turned off notification for manual feeding in your
PrintMonitor, the Desktop PrintMonitor will also have manual feed notification
turned off.

If you want to change how the Desktop PrintMonitor notifies you about manual
feeding, follow this procedure:

1. Hold down the Shift key and restart your computer, keeping the Shift key
depressed until the message "Extensions off" or your normal desktop appears.

2. Open your System Folder and then open your Extensions folder.

3. Double-click the PrintMonitor application.

4. Choose Preferences from the File menu.

5. Select your manual feed option and click OK.

6. Close the PrintMonitor.
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7. Restart your computer.

Turning Off or Removing the Desktop Printing Software

Removing a Desktop Printer Icon

You can remove an individual desktop printer icon by dragging it into the trash.
If you have only one desktop printer, you can't get rid of the icon by dragging
it to the Trash. (The icon will reappear if you do.) To get rid of the desktop
printer, you must first select a different desktop printer as the default
printer and then drag the desktop printer icon to the Trash. If you don't want
to use desktop printer icons, see "Turning Off the Desktop PrintMonitor" or
"Removing Desktop Printing Software" for information about how to remove the
desktop printer software.

Turning Off the Desktop PrintMonitor

If you don't want to use desktop printers, you can turn off the Desktop
PrintMonitor using the Extensions Manager (available on Macintosh System 7.5,
the current version of the Mac OS).

To turn off the Desktop PrintMonitor:

1. Open the Extensions Manager control panel in the Control Panels folder.

2. Click to deselect (uncheck) the Desktop PrintMonitor, Desktop Printer
Extension, and Desktop Printer Spooler extensions in the panel.

3. Click the close box to close the control panel.

4. Restart your computer.

Removing the Desktop Printing Software

The desktop printing software uses both the Desktop PrintMonitor and the
PrintMonitor software. The Desktop PrintMonitor requires 200-400K bytes more
free system memory in addition to the memory required by the PrintMonitor.  If
you don't want to use the desktop printing software, you can remove it.

To remove desktop printing software:

1. Restart your computer with the extensions off by holding down the Shift key
and choosing Restart from the Special menu. Hold the Shift key down until the
message "Extensions off" appears or until your normal desktop appears.

2. Drag the following files from the Extensions folder to the Trash:

- Desktop PrintMonitor 1.0.3
- Desktop Printer Spooler 1.0.3
- Desktop Printer Extension 1.0.3
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3. Restart your computer.

Using Save or Open with Desktop Printers

When you choose Save or Open in your application programs, you will see your
desktop printers listed as if they were folders, but you should not save or open
any documents in them. If you do, you will not be able to access your
documents.

Having More Than Five Desktop Printers

If you want to have more than five or six desktop printers, you must increase
the Desktop PrintMonitor memory allocation by 12K for each additional desktop
printer you want. To do so, select its icon (it's in the Extensions folder
inside the System Folder), choose Get Info, type a larger number in the
Preferred Size box, then close the Get Info window.

About Creating Duplicate Desktop Printer Icons

If you use different versions of the printer software and print using the
Desktop PrintMonitor, you may create duplicate desktop printer icons for the
same printer. For example, say you select between two versions of the
StyleWriter software.  If you select your printer in the Chooser using one
version, and select it later using the another version, two desktop printer
icons will appear for that printer.  To avoid creating confusing duplicate
printer icons, primarily use one version of your printer software, or rename the
icons with distinguishing names.

Using Desktop PrintMonitor on a Non-English System

If no desktop printer icon appears after you install the printer software, it
may mean the Installer installed PrintMonitor 7.1.2 and did not install the
Desktop PrintMonitor. (PrintMonitor 7.1.2 is installed if you have an older
version of the PrintMonitor. Newer versions of the PrintMonitor are not
replaced.) You have three choices:
• Use PrintMonitor 7.1.2 (or a later version)
• Obtain a set of installation disks of the printer software in the language of
your system software from your Apple-authorized dealer and install it.
• Upgrade your system software to System 7.5 and install the printing software
again. An English-language version of the Desktop PrintMonitor is installed.

Low-Memory Troubleshooting

If you notice any of these symptoms, your Macintosh may be running out of
memory.
— The edges of some letters appear jagged.
— The Macintosh displays "out of memory" warning messages.
— Some portions of a document don't print.
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— Some text prints in the Geneva font instead of the font you selected.

To make more memory available, try these suggestions:

• Have only one program open at a time.

• Increase the amount of memory you give to the program you're printing from by
using the Get Info command (as explained in the documentation that came with
your Macintosh).

• Use the Chooser to turn off background printing, as explained in Chapter 2 of
the user manual.

• Remove any watermarks from your document.

• In the Page Setup dialog box, choose Portrait (normal) orientation instead of
Landscape (sideways) orientation.

• Desktop printing requires more memory to print than the old PrintMonitor.  You
can remove desktop printing by using the custom install option called
"PrintMonitor 7.1.2 (no Desktop Printing)."

•  When you print in the background, if you often get a message that there is
not enough memory to print on a certain desktop printer, you can give that
desktop printer more memory by selecting its icon and choosing the Get Info
command. Then increase the number in the Preferred Size box. (For more
information on increasing a program's memory, see the documentation that came
with your Macintosh.)

• As long as there are any print requests waiting to be printed, Desktop
PrintMonitor (the desktop printing software) remains active in memory, even when
background printing is off. If you are not printing in the background, you can
remove all print requests from your desktop printer queues to reduce memory
requirements by 160K.

• Use the Memory control panel to turn on virtual memory, as explained in the
documentation that came with your Macintosh.

• Try a program like RamDoubler.

• See the "Troubleshooting" chapter in the StyleWriter 1200 user manual for more
suggestions.

Watermark Tips

• When using a watermark, make sure the font that is in the watermark file is
also in the Fonts folder inside your System Folder.  If you give the watermark
file to someone, they also need any fonts that it uses in order to use the
watermark in their own documents.

Tips on Sharing Your Printer
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• To avoid confusion, be sure to give each shared StyleWriter 1200 printer a
unique name. If you have more than one printer with the same name in a single
AppleTalk zone, the Chooser will display only one of them.

• To clean the print head of a shared StyleWriter 1200, you must send the
request from the Macintosh that is directly connected to the printer.

Miscellaneous Printing Tips

• When printing very light colors in grayscale mode, you may see thin lines fade
or break up. If this happens, pick a darker color for the affected object, or
try printing with the Pattern halftoning option selected.  (In the Print dialog
box, click the Options button, then select the Pattern option.)

• For best results when printing envelopes, do not put images or text along the
bottom edge of the envelope.

• If you use the StyleWriter 1200 software to print on an older StyleWriter as
well as on the StyleWriter 1200, not all the valid options (such as glossy
paper) will show up when you switch back to the StyleWriter 1200 until after you
print at least one page.

Printing With QuickDraw GX

If you have QuickDraw GX on your system, the StyleWriter 1200 Installer will
automatically install everything you need for printing with QuickDraw GX.

• If you installed QuickDraw GX after you set up your StyleWriter 1200, you must
reinstall the StyleWriter 1200 software.

• After you click the Print button to print a complex document, you may notice a
delay before you see printer activity.

If printing with QuickDraw GX doesn't produce satisfactory results, you can use
the GX Helper utility to turn off QuickDraw GX and use the regular QuickDraw
printing software.  For more information, see Appendix E of your user manual.

Using the StyleWriter 1200 With Application Programs

If you have problems printing from a specific program, it may be a problem in
that program.   If you have problems, contact the publisher of the program. In
some cases a newer, more compatible version of the software may be available.

• In some programs—such as Microsoft Word 5.1, WordPerfect 3.0, ClarisWorks 2.0,
and Symantec GreatWorks 2.0—rotated text created within the program may print
with jagged edges. For best results, create the rotated text in another program
and paste it in.

Notes About Specific Programs
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The following list describes some special situations that you should be aware of
when working with specific programs. (There may be other problems with these
programs or with other programs not mentioned in this document.)

Adobe Type Manager

• If you rotate Adobe Type 1 fonts in FreeHand 3.11 and then paste them into
another program, your Macintosh will display a system error when you try to
print.

• If you print rotated Adobe Type 1 fonts using FrameMaker 4.0, your Macintosh
will display a system error.

• If you print rotated Adobe Type 1 fonts that are also bold or italic using
Intellidraw, and text will not print, you probably need to upgrade to ATM
version 3.8.1.

• If you get incorrect output when you try to print rotated and flipped Adobe
Type 1 fonts, try using a TrueType font instead.

• When Adobe Type 1 fonts are both outlined and underlined, characters may be
misprinted (incorrect locations, multiple characters in same location, lower
portions of characters shift left or right).

Adobe Dimensions

• Always print your documents in the foreground when using Adobe Dimensions.  To
turn background printing off, open the Chooser, click Off for Background
Printing.  If you accidentially print in background and your Macintosh crashes,
you may have to restart with extensions off, open your desktop printer and drag
all print requests from the queue.

Adobe Illustrator 5.0

• Unless you have at least 10 MB of free disk space on your startup disk, you
will see a "disk is full" error message when you try to print. The more complex
the document, the more space you need.

• If banding occurs in gradient fills, try printing with the Pattern halftoning
option selected. (In the print dialog box, click the Options button, then select
the Pattern option.)

Aldus PageMaker 5.0

• To see the StyleWriter 1200 Page Setup and Print dialog boxes, click the Setup
button in PageMaker's Print dialog box.

• When printing rotated PICT or EPS images, be sure background printing is
turned on in the Chooser.  If you must print in the foreground, rotate the image
in another program, then import it into PageMaker in the orientation in which
you plan to print it.

• PageMaker 5.0 prints pages in reverse order on the StyleWriter 1200, which may
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be particularly confusing if you are using 2-up or 4-up printing. To print the
first page first, turn on the Reverse Order option in the Print dialog box.

ClarisDraw 1.0v1

• If you have problems printing in the background, you may want to increase the
Desktop PrintMonitor extension's preferred size to 300K (by using the Get Info
command, as explained in the instructions that came with your Macintosh). The
extension is located in the Extensions folder inside your System Folder.

ClarisImpact 1.0v1

• If you have problems printing ClarisImpact documents from a Power Macintosh,
upgrade to ClarisImpact 1.0v3.

DeltaGraph Pro 2.0.3

• When printing charts, always click the QuickDraw button in the Print dialog
box.

FrameMaker 4.0

• If you import text as a graphic, you can crop it on the screen but it will
print uncropped.

• Rotated text in large point sizes will print as a gray box. For best results,
break up the text blocks into smaller pieces or individual characters.

MacDraw II 1.1 v2

• To print in grayscale, follow the usual instructions and also turn on the
Print Color Patterns in the Print Options dialog box and select Color in the
Image pop-up menu in the Print dialog box.

• If you experience problems when printing your MacDraw II document with layout
of 2-Up or 4-Up, try using a different program, like ClarisDraw.

Microsoft Excel 4.0 and Lotus 1-2-3

• To print in grayscale, check the Print Using Color option in the Print dialog
box and select Color in the Image pop-up menu.

Microsoft Excel 5.0

• If colored cell borders drop out when printing, try using yellow or brown or
you can use the line tool in the Drawing tools palatte.

Microsoft Word 6.0

• When you cancel a print request from MicroSoft Excel 6.0, some of the document
will still print.  If you are using desktop printing, try stopping the print
queue on your desktop printer and then removing the print request instead of
cancelling.  To do this, click on you desktop printer icon and select Stop Print
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Queue from the Printing menu.

Print Shop Deluxe 1.0

• Make sure you open your document before printing.

SoftWindows 1.0

• You may not be able to print to your StyleWriter 1200 from SoftWindows.
Contact Insignia Solutions Inc. for more information on printing from
SoftWindows.

Studio/8 v 2.0 and Studio/32 v 1.2

• Always click the QuickDraw button in the Print dialog box.
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